Editing your web staff profile

The staff profile system allows you to easily maintain a record of your publications, research interests, teaching commitments, and other information about yourself. This information is then searchable from several web pages on the University website, and so it is in your interests to keep it up-to-date. The system is most useful for academic staff, but other staff may find some of its features useful as well.

Contents
1. What is your staff profile?
2. Editing your staff profile
3. Basic information
4. Esteem Indicators
5. Research specialities and International collaborations
6. Grant information
7. Teaching Commitments
8. Related links
9. Publications
10. Media contacts
11. Additional information
12. Looking at your staff profile
13. General Notes about the system
14. Delegating editing rights
In this document, the following conventions are used:

- A typewriter font is used for what you see on the screen.
- A **bold typewriter font** is used to represent the actual characters you type at the keyboard.
- A **slanted typewriter font** is used for items such as filenames which you should replace with particular instances.
- A **bold font** is used to indicate named keys on the keyboard, for example, Esc and Enter, represent the keys marked Esc and Enter, respectively.
- A **bold font** is also used where a technical term or command name is used in the text.
- Where two keys are separated by a forward slash (as in Ctrl/B, for example), press and hold down the first key (Ctrl), tap the second (B), and then release the first key.
## Contents

1. **What is your staff profile?** ................................................................. 1

2. **Editing your staff profile** ..................................................................... 1
   2.1. Searching for people ........................................................................ 2

3. **Basic information** .................................................................................. 3
   3.1. Information about yourself .............................................................. 3
   3.2. Controlling the display of your staff profile ...................................... 3
   3.3. Miscellaneous fields ....................................................................... 4
   3.4. Submitting changes to this information ........................................... 5

4. **Esteem Indicators** ................................................................................. 5
   4.1. Adding and editing esteem indicators ............................................. 5
   4.2. Removing an esteem indicator ......................................................... 5

5. **Research specialities and International collaborations** ....................... 6
   5.1. Adding a speciality .......................................................................... 6
   5.2. Editing and removing specialities ................................................... 6
   5.3. International Collaborations ............................................................... 7

6. **Grant information** .................................................................................. 7

7. **Teaching Commitments** ...................................................................... 7
   7.1. Adding teaching commitments ......................................................... 8
   7.2. Editing and removing teaching commitments .................................... 8

8. **Related links** ......................................................................................... 8
   8.1. Adding a related link ...................................................................... 8
   8.2. Removing a related link .................................................................. 9

9. **Publications** ......................................................................................... 9
   9.1. Adding new publications ................................................................. 10
   9.2. Editing Publications ....................................................................... 13
   9.3. Removing publications .................................................................. 16
   9.4. Multiple Authors ........................................................................... 16
   9.5. Displaying publications and REF Information .................................. 17
   9.6. Working with EndNote ................................................................. 17
   9.7. Working with BibTeX ..................................................................... 18
   9.8. Importing from the Web of Science ............................................... 19
   9.9. Exporting CSV files ....................................................................... 19
   9.10. Transferring publications to Durham Research Online .................... 19
   9.11. Multiple versions of the same publication ..................................... 20
   9.12. Associating publications with research groups and projects .......... 21

10. **Media contacts** ..................................................................................... 21
    10.1. Adding a media contact ............................................................... 22
    10.2. Removing a media contact .......................................................... 22

11. **Additional information** ...................................................................... 23
    11.1. Images and other files ................................................................. 24
12. Looking at your staff profile .......................................................... 25
13. General Notes about the system ...................................................... 25
   13.1. Formatted text ............................................................................ 25
   13.2. Accented letters, non-latin letters, symbols and special characters .... 26
14. Delegating editing rights ................................................................. 27
1. What is your staff profile?

Your staff profile is an online record of information about you and your work at the University. It can include the following information:

- Your name, job title, and contact details.
- Your biography.
- A photograph.
- Publications and other research outputs
- Information about your research (including research interests, research groups and projects that you are a member of, grants awarded)
- Information about your teaching (including teaching groups you are in, and your teaching commitments)
- Media contact information
- Links related to your research or teaching
- Additional information in a flexible format

The majority of the information on the staff profile can be edited by you.

Information from your staff profile can be displayed in many places, including:

- Your department’s website, for example in a staff list or a research project description.
- The central research expertise directory

2. Editing your staff profile

Go to the following URL:

http://cms.dur.ac.uk/CMSADMIN/data/profiles/

You will be asked for your ITS username and password.

The majority of people at this stage will see only one link, which says “My profile”. Use this link. If you see other links, their function is explained in Guide 182 which you should also obtain a copy of.

One of two things should happen at this point:

This means that your username has not yet been registered with the profile system. Possible causes for this are:

- Your department is not in the system. This is unlikely, but possible.
- If you are a new member of staff, you may not yet have been assigned to your department in the profile system. You should contact your departmental profile administrator who will be able to add you. If you appear on your department’s list
at [http://www.dur.ac.uk/directory/units/](http://www.dur.ac.uk/directory/units/) then you should be able to use the system.

Once you are registered (or if you were already registered), you should instead see a page containing links like this (exactly which links you see may vary)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Lockout</td>
<td>iT</td>
<td>If this is set, the staff member will not be able to edit their profile (except by an administrator). If this is set on, to insert accented characters into staff e-mail addresses, use the &quot;Charmap&quot; utility on Windows to do so. For more information, see Section 13.2 of IT.</td>
</tr>
<tr>
<td>Family Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Given Names</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initials</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qualifications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photograph Link</td>
<td></td>
<td>Images will be displayed without resizing. Use the &quot;Charmap&quot; utility on Windows to do so. If you upload a profile photo, then the preview link below or on your profile page is the same image. For more information, see Section 13.2 of IT.</td>
</tr>
<tr>
<td>Personal Webpage</td>
<td><a href="http://www.dur.ac.uk/">http://www.dur.ac.uk/</a></td>
<td>Your Researcher ID, if you have one.</td>
</tr>
</tbody>
</table>

### 2.1. Searching for people

Some forms in the profile system require an email address to be entered to identify people (for instance, when adding them as co-authors to your publications). You can search the University Directory using the form at the top of the navigation bar.

Search Directory:

- **Include left staff**
- **Search** (by surname)

This will give a list of results including an email address (or a username if they have no email address) giving the name and category of each person:

<table>
<thead>
<tr>
<th>4 records found. Use the email address (or username if email is unavailable) displayed to identify them in forms.</th>
</tr>
</thead>
<tbody>
<tr>
<td>- <a href="mailto:duke@durham.ac.uk">duke@durham.ac.uk</a> (Temporary Staff and other temporary accounts)</td>
</tr>
<tr>
<td>- <a href="mailto:duke@durham.ac.uk">duke@durham.ac.uk</a> (Academic, Teaching or Management Staff)</td>
</tr>
<tr>
<td>- <a href="mailto:duke@durham.ac.uk">duke@durham.ac.uk</a> (Academic, Teaching or Management Staff)</td>
</tr>
</tbody>
</table>

Copy the appropriate email address from the list and paste it into the form.

(This functionality requires a relatively modern web browser)
3. Basic information
There are several fields of basic information, reached by using the "My Profile" link. You can also get back to this page later using the “Basic Details” link.

3.1. Information about yourself

**Family Name, Title, Given Names, Initials**
The components of your name. You may leave blank any that do not apply. Initials should not include initials of your family name(s).

**Qualifications**
Your academic and professional qualifications

**Photograph URL**
The URL of a photograph of you. Your department may have a system for centrally managing these photographs, or it may be up to you to provide your own.

**Personal webpage**
The URL of your personal webpage (e.g. http://www.dur.ac.uk/a.n.other/). If this is entered, it will appear with your contact details on your staff profile.

**Biography**
Biography information is now edited in the “additional information” section of your profile. See Section 11 of this guide. If you previously had a biography entered in this part, it was automatically transferred to the “additional information” section on 17 May 2006.

**Publication aliases**
The profile system will be able in some cases to automatically match your name with author lists on profiles. To do this, it expects the name on the author list to be your surname and the first letter of your preferred name. If it is anything else, you may want to enter the alternative aliases in this box, one per line.

**Researcher ID, SCOPUS Author ID**
These fields help link your record to external publication databases. The “Researcher ID” field will also add a link from your web staff profile to the Researcher ID database.

3.2. Controlling the display of your staff profile
Your department may have a policy for how some or all of these should be set. Please check with your departmental administrator if you are uncertain.
Link to all publications

Only publications that are marked for display on your staff profile will be displayed on your staff profile page. However, if this option is on, there will be a link on your staff profile page to a list of all your published publications.

Display unpublished publications

Normally, only publications that are marked as ‘Published’ will be displayed on your staff profile, even if they are marked for display on your staff profile. Turning this option on allows draft and pre-publication research to also be displayed on your staff profile.

Email contact methods

You can choose to have either a link to a contact form, or your email address, or both displayed on your staff profile. You can also choose to remove both methods from your staff profile.

Using the contact form link has the advantage that people with a web browser that doesn’t integrate with their email client (or people without access to their email client – for example people in internet cafes) can easily contact you. On the other hand you may have the occasional problem with mistyped email addresses from the sender making it difficult to reply.

Using the email address will make it very easy for people to use their preferred email program to contact you, but of course may increase the amount of spam email that you get (although we do take some steps to reduce this).

For the maximum ease of people being able to contact you, it is probably best to make both options available. We strongly recommend that you allow at least one.

Users on the University internal network will always be able to view your email address in the Directory or on staff lists, regardless of this setting.

Public contact details

If this option is on, your university telephone number and other contact details will be displayed on your staff profile.

Most recent esteem first

Normally your esteem indicators (if you choose to make any public) will be displayed in chronological order on the web. Choosing this box will display them in reverse order (i.e. most recent first)

3.3. Miscellaneous fields

Editor

This field cannot be edited directly. It provides a list of the people who have most recently updated this record.
3.4. **Submitting changes to this information**

Once you have made the desired changes to this information, use the ‘Edit Personal Information’ button to update it.

4. **Esteem Indicators**

Use the ‘Esteem Indicators’ link. This used to be called ‘Collaborations and Consultancy Activities’.

4.1. **Adding and editing esteem indicators**

Select the esteem indicator you want to edit from the drop-down list, or use ‘New entry’ to add a new one, and then use the Continue button.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>2011</td>
</tr>
<tr>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Public Display</td>
<td></td>
</tr>
</tbody>
</table>

Enter the details of the esteem indicator into the boxes provided. You should complete both the summary and description boxes, but the URL is optional.

If you wish the esteem indicator to be displayed on the web, use the ‘Public Display’ checkbox.

4.2. **Removing an esteem indicator**

Select the checkboxes by the entry or entries you want to remove, and use the ‘Remove from staff record’ button.
5. Research specialities and International collaborations

You can enter details of your research interests. Start by using the ‘Research Specialities’ link.

You should check your departments’ list of research groups and expertise and try to use the same terminology where possible. Contact your departmental administrator if you are unsure.

5.1. Adding a speciality

Enter a description of your research expertise and use the ‘Add to staff record’ button. Research expertise will normally be displayed in alphabetical order, but you can override this using ‘Display Order’. Expertise will be displayed with lowest display order first.

5.2. Editing and removing specialities.

To edit specialities, use the linked name, and you will get a form to edit the description and display order. The names are displayed here in the order that they are displayed on your profile – so in the example above, display orders of ‘1’ for ‘research areas’, ‘2’ for ‘a research speciality’, and ‘3’ for ‘a piece of research’ are overriding the normal alphabetical ordering.
To remove specialities, select the speciality or specialities you wish to remove and use the ‘Remove from staff record’ button.

5.3. **International Collaborations**

International Collaborations are edited in the same way as Research Expertise areas. Start by using the “International Collaborations” link.

6. **Grant information**

Grant information is drawn from the central Oracle Financials and MITRE Grants databases. Go to the "Grant Information" link to review the grants associated with you (grants awarded before 2001 are generally not available), and to select grants for display on the web.

**New grant data**

Select grants to be displayed on the web by using the checkboxes. If any information about a grant is incorrect, please contact your departmental research administrator.

- [x] R1, £6000.00, 2005-07-01 - 2010-12-31
- [x] RF, £39268.97, 2007-08

Select the grants that should be displayed on the web and use the “Update grant visibility” button.

The grant information is drawn from central databases, so if a grant is incorrectly assigned to you, or a grant that you should have is missing, please contact your departmental research administrator. If you wish to change the grant description, use the link to get to enter a replacement description. If you have already entered a replacement description, you can restore the original description by making the replacement box empty.

7. **Teaching Commitments**

You can enter details of your teaching commitments by using the ‘Edit Teaching Commitments’ link.
7.1. Adding teaching commitments

Working on: 

**New Teaching Activity**

- **Description**: 
- **Hours taught each year**: 
- **Add to staff record**

**Existing Teaching Activities**

- (1st year) (0 hours)
- (3rd year option) (0 hours)
- (Masters level) (0 hours)
- (Masters level) (0 hours)
- **Remove from staff record**

To add a teaching commitment, enter the description and the number of hours taught into the form, and use the ‘Add to staff record’ button.

7.2. Editing and removing teaching commitments

To remove a teaching commitment, select the box by its name and use the ‘Remove from staff record’ button. You can edit existing commitments by clicking on their name.

8. Related links

You can set up links to other pages of interest by using the ‘Edit links related to your research and teaching’ link.

8.1. Adding a related link

Enter the URL and the link text into the form and use the ‘Add to staff record’ button. Remember that the link text needs to make sense out of context – don’t use phrases like “click here”.

**New Research/Teaching Links**

- **Link text**: 
- **Link Destination**: 
- **Add to staff record**

**Existing Research/Teaching Links**

- 
- 
- 
- 
- **Remove from staff record**
8.2. Removing a related link
Select the box by its name and use the 'Remove from staff record' button.

9. Publications
Use the 'Edit publications' link to edit your publications, select which ones to display on your staff profile, and keep your publication record up-to-date.

Publications
Use the publication title as a link to edit the publication information. Publications can remove the association between the publication and yourself by selecting the check box.

Add new publication record
Sort by journal name | Sort by authors | Sort by year

- 2011:
- 2011:
- 2010:
- 2010:

A number of new publication editing options will appear in the navigation bar.

<table>
<thead>
<tr>
<th>Publication Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Publications</td>
</tr>
<tr>
<td>Add Publication</td>
</tr>
<tr>
<td>Transfer to Durham Research Online</td>
</tr>
<tr>
<td>Select for display and REF</td>
</tr>
<tr>
<td>Add co-authors</td>
</tr>
<tr>
<td>Link to research groups</td>
</tr>
<tr>
<td>Mark versions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Publication Import/Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import from EndNote</td>
</tr>
<tr>
<td>Export to EndNote</td>
</tr>
<tr>
<td>Import from BibTeX</td>
</tr>
<tr>
<td>Export to BibTeX</td>
</tr>
<tr>
<td>Import from Web of Science</td>
</tr>
<tr>
<td>Export to a CSV file</td>
</tr>
<tr>
<td>REF Submission</td>
</tr>
</tbody>
</table>
9.1. Adding new publications

Use the ‘Add publication’ link

New publication
You can enter publications by searching for them in CrossRef by DOI or key fields (works best for journal articles), or enter the details manually.

- Import by DOI (Digital Object Identifier)
  DOIs can be found on the publisher website - e.g. 10.1088/0332-1677/31/2/306
  DOI

- Import by Publication details
  You must enter the journal name or the ISSN/ISBN, the year of publication, and either the author name or the starting page.
  - If you know the DOI, searching by DOI is significantly quicker and more reliable.
  - Using ISSN/ISBN and starting page is more reliable than author name and journal name, because there is less chance for variation in spelling or formatting between your entry and the CrossRef database.
  - Entering too much information can stop CrossRef returning your results to us - if nothing is found, try cutting your search back to the minimum required fields.

  | Author name |
  | Journal/Book/Conference |
  | Volume |
  | Issue |
  | Starting page |
  | Year |
  | ISSN/ISBN |

- Enter details manually
  Select category: Articles magazine

This will take you to a basic publication details page. There are multiple options to quickly add publications here – you can import from the external CrossRef database of publications by entering the publication’s DOI (digital object identifier – a unique ID issued by the publisher), or by entering certain key pieces of information to search CrossRef’s database. Alternatively, you can choose to enter the details manually by selecting a publication category and working from there. For publications outside of CrossRef’s scope, this is the main method of entry.

9.1.1. Searching CrossRef

Journal articles are generally available in CrossRef, and entering them this way can save you some time.

If a CrossRef search is successful, you will be given the information provided in CrossRef for that publication and can use ‘Import this publication’ to begin adding the publication to your profile.

CrossRef search results

Results found in CrossRef

<table>
<thead>
<tr>
<th>Result 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>DOI</td>
</tr>
<tr>
<td>Journal/Book</td>
</tr>
<tr>
<td>Article</td>
</tr>
<tr>
<td>Author</td>
</tr>
<tr>
<td>Volume</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>Page</td>
</tr>
<tr>
<td>Year</td>
</tr>
<tr>
<td>ISSN/ISBN</td>
</tr>
</tbody>
</table>

| Import this publication |
Not all publication fields are recorded in CrossRef – it varies between publishers – so you may need to do some manual addition of a few fields. For example, the article above does not have its title in CrossRef.

If the CrossRef search is unsuccessful, you can choose to create an entry from the search terms you used.

**CrossRef search results**

*No results found in CrossRef for this search.*

[Create a new publication entry based on this search]

**New publication**

You can enter publications by searching for them in CrossRef by DOI or key fields (works best for journals).

**Import by DOI (Digital Object Identifier)**

DOI can be found on the publisher website - e.g. 10.1088/0261-9370

[DOI]

[Search by DOI]

**Import by Publication details**

You must enter the journal name or the ISSN/ISBN, the year of publication, and either the author name:

- If you know the DOI, searching by DOI is significantly quicker and more reliable.
- Using ISSN/ISBN and starting page is more reliable than author name and journal name, because formatting between your entry and the CrossRef database.
- Entering too much information can stop CrossRef returning your results to us - if nothing is found.

<table>
<thead>
<tr>
<th>Author name</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal/Book/Conference</td>
<td>Journal of examples</td>
</tr>
<tr>
<td>Volume</td>
<td>4</td>
</tr>
<tr>
<td>Issue</td>
<td></td>
</tr>
<tr>
<td>Starting page</td>
<td>118</td>
</tr>
<tr>
<td>Year</td>
<td>2011</td>
</tr>
<tr>
<td>ISSN/ISBN</td>
<td></td>
</tr>
</tbody>
</table>

[Search by details]

Use the “Create a new publication entry based on this search” button to copy the details you entered in the search box into a new publication record.

**9.1.2. Entering initial publication details**

Whether you created a publication from a CrossRef search or created it manually by selecting the category, you then reach this page. If you are entering data manually, you will probably need to complete most or all of the available fields. If you imported from CrossRef, then you may only need a small amount of additional information, and minor adjustments to the CrossRef-provided data.
Enter in the details you need, and then use the ‘Submit publication’ button. The system will then check to see if the publication has already been entered, which may be the case if you have co-authors at Durham.

If there are duplicates or potential duplicates already in the system these will be listed.

**Create record**

The following publications with similar details are already in the system. If any of these are the publication you are currently adding, then add yourself as a co-author.

* [Add me as a co-author](#)

If none of the publications above appear to be duplicates, create a new publication record using the button below:
It is possible that the publications are not actual duplicates, but simply have a similar title or other similarities of data. In this case, or if there are no duplicates, you can create a new record using the “Create publication” button. If one is a duplicate, instead use the ‘add me as a co-author’ link to add the existing publication record to your profile.

In cases where the system is very sure that there is duplication, you will not have the option to create a new record.

Once the publication is created, it will then appear on your list of existing publications, should you need to edit it further.

9.1.3. Existing publications

To edit an existing publication, go to “Edit publications”, and follow the appropriate link.

9.2. Editing Publications

Publications have several fields for their detail, not all of which will apply to every publication – if a field does not apply, leave it blank. Not every field is available for every publication (for example you cannot add ‘Conference Name’ to an ‘Edited Book’) Once you have entered the publication details use ‘Alter Record’ to save the changes.

There are two modes for editing publications – Basic Mode, which has around 10-15 of the most common fields needed for display on the web, and Full Mode, which has a larger number of fields useful for providing additional information. You can switch between the two using the link at the top of the publication (do not use this link if you have unsaved changes)

An explanation of some of the more common fields follows.
Language
The language that the publication is primarily written in. Only languages which are specifically requested will appear on the list of options. If you have a request for another language, please email it to itservicedesk@durham.ac.uk

Author List (and/or Editor List if appropriate)
This should be a list of authors or editors, one on each line. Authors or editors internal to the University should have an asterisk '*' at the start of their line (and optionally also at the end).

Note: previously the format for this field was to enter all the information onto a single line and there may be some records where this is still the case. To allow the system to distinguish between a publication in the old single-line format, and a publication with only one author, place a blank line at the end of single-authored records.

New publications that are entered in a single-line format (for example via import from EndNote or BibTeX) will be automatically converted to a multi-line format overnight, if this is possible.

Location URL
If the publication is available to view online, enter the URL in this field.

ISSN or ISBN
If there is an ISSN or ISBN for the publication, enter it here.

Image URL / Image Description*
If you want to insert a picture of the publication, enter the URL, and a description of what aspect of the publication is represented by the image here (e.g. “Front cover”)

Keywords*
This contains up to five keywords that will help with the filing of the document in a search engine. This field is not currently used by the profile system, but will be used when integration with the Library E-Prints Archive is complete.

Abstract*
The abstract of the publication.

Additional Information*
Additional public information about the publication that can be displayed on the web as part of the extended information. This can be used for public notes (compare with the private Notes field below)

Publication References*
The references to other publications that this publication makes.
Notes
Any (private) notes you have about the publication. These notes will not be visible on the web but will be visible to department and university research administrators.

Status
The current status of the publication. Usually, only ‘Published’ publications will be visible on your staff profile (but see Section 3.2 for information on options that affect this).

Refereed
Whether or not the publication is refereed. You must set this field or the publication cannot be included in the digital repository (e-prints) service. The default is for this field not to be set.

You can now:
- Link co-authors to this publication
- Add an abstract, list of references, or other additional information to the publication record
- Transfer publication to Durham Research Online (DRO) or upload full text

Once you have edited a publication, you will get a set of additional links to quickly carry out other common tasks related to the publication.

9.2.1. Recategorising publications
If you wish to change the category of an existing publication, for whatever reason, go to edit the publication as above. At the top of the publication you will see an indication of the current category and an option to change the category.

If you use the ‘Change the category of the publication’ link then you will get a form to select a new category.
Select the new category and use the Recategorise button.

Any information about the publication common to the old and new categories will be unchanged. Information that is in the old category but not the new will remain (in case you change the category back) but never be used.

Where two publications have fields with similar but not identical meaning information may be transferred from one to the other when the category changes.

9.3. Removing publications

If you wish to remove a publication from your staff profile, select it from the list and use the ‘Remove publications from my list’ button. Generally, you should set publications to not be displayed on your staff profile instead of removing them.

You cannot delete a publication record from the profile system, since there may be multiple authors.

9.4. Multiple Authors

If a co-author of the publication is also working at Durham University, you should use the ‘Add co-authors’ function to also assign the publication to them.

If one of your publications was co-authored by someone else at the University, you will see entries in the database.

You cannot remove co-author information once it has been added. If you add co-author information to remove it:

- **Publication:** [Dropdown]

Enter either the Durham email address or ITS username of the co-author.

- **Co-author:** [Email or username]

  - [Register co-author]

Select a publication of yours from the drop-down list, enter the co-author's Durham email address or ITS username, and use the ‘Register co-author’ button.

If your co-author has already entered that publication, the profile system has duplicate-checking functions that should prevent you from creating a copy of the record – if this happens, and your co-author has not added you as a co-author yet (the publication will be in your list of publications if they have) then you will get a link in the duplicate-checking message allowing you to add yourself as a co-author.

9.4.1. Searching for publications

You can also add yourself to existing publication records that you are a co-author of. See section 9.1 for more information.
9.5. **Displaying publications and REF Information**

To select publications for display on your staff profile, or submission to the RAE, use the ‘Select for display and REF’ link.

**Select publications**

Select the publications you want to display on your staff profile.

<table>
<thead>
<tr>
<th>Web display Profile</th>
<th>Number</th>
<th>REF Suggest for</th>
<th>Publication</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td>2011:</td>
</tr>
<tr>
<td>✔</td>
<td></td>
<td>✔</td>
<td>2011:</td>
</tr>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td>2011:</td>
</tr>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td>2011:</td>
</tr>
<tr>
<td>✔</td>
<td></td>
<td></td>
<td>2011:</td>
</tr>
</tbody>
</table>

The ‘Profile’ column controls whether the publication is shown on your staff profile. Publications without this box on will still be listed publicly if you have ‘Link to all publications’ turned on in your settings (see Section 3.3). You can choose at the time you enter a publication (including entry by import from other systems) whether this should be on or not.

The ‘Number’ column can be used to set an explicit ordering for publications when displayed on your staff profile page on the web. **Generally it is best not to do this**, but if you feel it would be useful to set a specific ordering, please follow these guidelines:

- Make sure that you number from 1 upwards, without leaving gaps, and without duplicating numbers
- Make sure that all publications selected for profile display have a number.

The ‘Suggest for REF’ column is used to suggest publications for the next REF. If you mark this box for a publication, the name of the publication will become a link and you will be able to add REF-specific information by using that link. Further guidance on REF-specific information is available from the Research Office.

Proposals for REF submission will be checked for information quality and correctness by the Library (though obviously you should try to ensure that the record is correct and complete before proposing it).

After making any changes to these columns, use the Update Choices button below the table.

9.6. **Working with EndNote**

The profile system can work with EndNote to manage your publications.

9.6.1. **Importing from EndNote**

If you use EndNote to keep details of your publications, you can import your publications from EndNote into the profile system.

Use the ‘Import from EndNote’ option and follow the instructions on that page.
If you have the appropriate level of access to the computer and EndNote is running, you are strongly recommended to use a style that allows the import of records where some of the fields (e.g., Notes, Abstract) can contain multiple lines. You need EndNote version 8 or later to use this import style.

The filter file should be placed in the 'Styles' directory of your EndNote installation (e.g., C:\Program Files\EndNote 8\Styles). To Delimited, style in the instructions below.

To transfer details of your publications from EndNote into the directory:

- Open your publication library in EndNote.
- Go to Edit -> Output Styles in the menu.
- If Tab Delimited (or the Durham custom style above) is already an option in this sub-menu, go to step 6.
- Select 'Open Style Manager'.
- Scroll to 'Tab Delimited' in the styles list.
- Check the checkbox by 'Tab Delimited'.
- Close the style manager.
- Go to Edit -> Output Styles in the menus again.
- Select Tab delimited.
- Select your publications to import into the database. Make sure that you only select your publications, and only select those that are for the import.
- Use the 'Show Selected References' option in the References menu. All publications you have not selected should be hidden.
- Go to File -> Export in the menus.
- Make sure 'Save as type' is 'Text File (*.txt)'.
- Enter a filename (e.g., mypublications.txt)
- Press the 'Save' button.
- Start notepad (or another text editor).
- Open the mypublications.txt file.
- Select all (Edit -> Select All in notepad's menus).
- Copy the text (Edit -> Copy in notepad's menus).
- Paste the text into the text box on this page (often Edit -> Paste in your browser menu when the cursor is in the text box).

If you are able to install EndNote export styles, you should probably use the custom export style contributed by Anthony Beck from the Geography department, as this allows the import of publication records containing multiple lines (for example in an abstract). Otherwise, you will only be able to import records that do not contain multiple lines.

Due to the differences in information stored by EndNote and stored by the profile system, imports may not always work perfectly. You should check your imported publications before displaying them on your staff profile.

9.7. **Working with BibTeX**

The profile system can work with BibTeX to manage your publications.

9.7.1. **Importing from BibTeX**

Select the 'Import from BibTeX' link.

Copy the BibTeX file (.bib) into the text area and use the 'Import BibTeX data' button.
9.7.2. Exporting to BibTeX

Use the ‘Export to BibTeX’ link to create data to copy and paste into a .bib file.

Some publications may not have sufficient information stored in the profile system to generate a complete BibTeX entry. You will get an error for each of these publications.

Provided you have made reasonably complete publication entries this error should be rare. If you believe that the information is in the publication entry, but the BibTeX exporter is not finding it, please contact cms@durham.ac.uk

9.8. Importing from the Web of Science

Use the ‘Import from Web of Science’ link to get instructions for generating a BibTeX file from your records on Web of Science. You can then import this file as described in section 9.7

9.9. Exporting CSV files

To export a CSV (comma-separated values) formatted file for import into other applications (for example Excel or Access), use the “Export to a CSV file” option to get a list of all your current publications. Copy and paste this list into Notepad or another text editor, and save the file. You can then import this file into any application that supports the CSV format by following the import instructions for that application.

9.10. Transferring publications to Durham Research Online

To upload a publication to Durham Research Online (DRO) use the “Transfer to Durham Research Online” link.

Select the publication you wish to transfer from the drop-down list, and use the “Select publication” button.
To request that the publication be transferred to DRO, turn on the checkbox. Once the publication has been transferred, the checkbox will be replaced with a notification that the publication is now in DRO.

If you have a suitable full-text copy of the publication, the “Upload full text” field will allow you to copy it from your local computer. This will also be transferred to DRO. Once a transfer has taken place (or if the library adds the document to DRO outside of the profile system), this field will be replaced by a notice of the upload time.

9.11. Multiple versions of the same publication
If two of your publications are versions of each other, you can enter this relationship using “Mark one publication as a later version of another”.

Add version information to publications
If one of your publication records is a later version of another publication, (for example, a preprint and published version), you could enter this relationship. If you have three versions of the same publication, then set the second to be a later version of the first.

Select the earlier and later versions, and use the ‘Set version information’ button.

You can remove version information by selecting the checkbox and using the ‘Remove version information’ button.

If you have three versions, where A is a later version than B, and both are later versions than C, then make A a later version of B, and make B a later version of C.

The system will give an error if you attempt to create a loop of versions (i.e. A is a later version of B and B is a later version of A, or any more complex loop with the same effect)
9.12. **Associating publications with research groups and projects**

If your department has set up research group and project records you can associate your publications with groups and projects of which you are a member. This improves the information provided on the group and project web pages.

Select the “Associate publications with research groups and projects” link from “Publication options”, and you will be given a drop-down menu of your publications, and the groups and projects of which you are a member.

Select the appropriate groups and publications, and use the “Associate publication” button to link them. If you make a mistake, select the checkbox for that link from the “Existing publications” section of the page, and then use the “Remove associations” button.

**Associate publications and research groups or projects**

**Associate publications**

Your research group and project membership is set up by your departmental admin below, please contact your departmental administrator.

- **Publication**: 2005:  
- **Group or Project**: Group: Anthropology in Development

**Existing associations**

Select the checkbox and use the 'remove associations' to remove incorrect or un

**With Groups**

- Anthropology in Development: 2010,
- Anthropology in Development: 2010,
- Anthropology in Development: 2010,
- Anthropology in Development: 2000

10. **Media contacts**

You can edit what areas you are willing to be a contact for the media on by using the 'Edit Press Contact Information' link.
10.1. Adding a media contact

New entry

Please input a brief summary of one of your areas of expertise in layman's terms. After another area of your expertise.

Area of Expertise: 

Please categorise this area of expertise into the following categories, selecting as many:

- □ Anthropology
- □ Conflict and resolution
- □ Dreams and sleep
- □ Evolution
- □ Infant and child health
- □ International development
- □ Primate behaviour
- □ Biological and Biomedical Sciences
  - □ Bioactive chemistry
  - ☑ Ecosystems
  - □ Infectious diseases
  - □ Neuroscience
  - □ Plant sciences
  - □ Stem cells and regenerative medicine

Enter a brief summary of the area in which you will be contacted in the "Area of Expertise" box, and then tick the categories the area is covered by.

10.2. Removing a media contact

To remove a media contact, select it from the list of media contacts and use the 'Remove from staff record' button.
11. Additional information

Additional detailed information about yourself, your teaching and research activities, or anything else, can now be added. Use the "Edit additional information" link to start editing. A common use of this section is to include a biography.

Add new information or edit existing information

Additional information

Biography

Delete existing information

- Personal Website
- Biography
- Main research themes

Select ‘New entry’ to create a new piece of additional information, or select an existing entry to edit it, and use the ‘Continue’ button.

To delete an entry, check the box, and use the ‘Remove from staff record’ button.
You can have as many pieces of additional information as you like. Each piece has a heading, some body text (which can be formatted as described in section 13), and an optional image (copy and paste the URL into the ‘Image Url’ box). You can position the image above or below the text, or floated to the left or right of it.

You can choose what order the additional information should be displayed in using the display position field – items with a lower number will be displayed first. Items with the same number will be displayed in alphabetical order by heading.

You can get a quick preview of the current order by looking at the list in the ‘Delete existing information’ section of the previous screen – items are listed here in the same order that they are displayed.

You can restrict display of additional information to a particular department – select the department from the drop-down box in the “Department Restriction” field. If you leave this box blank, then it will be displayed on all departments. (If you are only in one department, it is simplest to leave this blank)

11.1. Images and other files

The “Upload images and other files” link allows you to upload small images and documents for use on your staff profile. Their main use is in the additional information section, but they can also be linked to from elsewhere.
Profile file uploading

There is a maximum size limit of 100k for images and 1000k for other files. Please note that images will be displayed on the web at their uploaded size, so resize them to the desired size before uploading. Files uploaded through this system will be entirely public. Do not upload confidential profile information.

Uploaded files are not initially linked to anywhere on your profile. To display a link to a file, enter the title of the file in the Biography, Links related to your research and teaching, or in a Publications record.

Once uploaded, files will be available on the live site in around an hour. If you need files removing, or need to upload files larger than the size limit, contact your CMS Site Administrators.

You can set an uploaded image as your profile picture by using the “Set as profile picture” checkbox.

12. Looking at your staff profile

Your staff profile, or parts of it, may be available from the public University website. You can also preview your complete staff profile from within the profile editor by using the ‘View Staff Profile’ link.

13. General Notes about the system

13.1. Formatted text

Where a large text box is available and supports HTML (such as the Biography box on the main staff editing page) you will normally get a graphical HTML editor. Instructions for using this editor can be found in ITS Guide 180, section 2.10. If you do not have Javascript enabled in a modern graphical browser, then this editor will not be available. You will then have two alternative ways of entering your text.

HTML

If you enter HTML code it will be displayed as-is. Note that if you enter any HTML tags you must format the whole contents of the text box this way. Furthermore, there is the potential to cause layout problems this way. It is recommended that you do not use this method of formatting unless absolutely necessary.

Simple formatting

This allows basic formatting in the following ways:
<table>
<thead>
<tr>
<th>You enter</th>
<th>The result is</th>
</tr>
</thead>
<tbody>
<tr>
<td>A new line</td>
<td>A line break</td>
</tr>
<tr>
<td>Two consecutive new lines</td>
<td>A paragraph break</td>
</tr>
<tr>
<td>Text enclosed in asterisks (e.g. <em>text</em>)</td>
<td>Bold text (text)</td>
</tr>
<tr>
<td>Text enclosed in underscores (e.g. <em>text</em>)</td>
<td>Italic text (text)</td>
</tr>
<tr>
<td>A URL (e.g. <a href="http://www.dur.ac.uk/">http://www.dur.ac.uk/</a>)</td>
<td>A hyperlink to that URL</td>
</tr>
<tr>
<td>A line entirely enclosed in square brackets (e.g. [Text])</td>
<td>A sub-heading</td>
</tr>
<tr>
<td>A line beginning with a dash followed by a space (e.g. – Text)</td>
<td>A list item. Consecutive lines like this will be made into a list.</td>
</tr>
</tbody>
</table>

For example:

<table>
<thead>
<tr>
<th>You enter</th>
<th>The result is</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Editing publications]</td>
<td>Editing Publications</td>
</tr>
<tr>
<td>Publication records are edited using the profile system editor. This can be found at <a href="https://www.dur.ac.uk:8443/CMSADMIN/data/profiles/">https://www.dur.ac.uk:8443/CMSADMIN/data/profiles/</a></td>
<td>Publication records are edited using the profile system editor. This can be found at <a href="https://www.dur.ac.uk:8443/CMSADMIN/data/profiles/">https://www.dur.ac.uk:8443/CMSADMIN/data/profiles/</a></td>
</tr>
<tr>
<td>The publication records can then be displayed on the web, or in other formats. These records will also be used in the REF.</td>
<td>The publication records can then be displayed on the web, or in other formats. These records will also be used in the REF.</td>
</tr>
<tr>
<td>The publication editor can store</td>
<td></td>
</tr>
<tr>
<td>- Citation information</td>
<td></td>
</tr>
<tr>
<td>- Abstracts</td>
<td></td>
</tr>
<tr>
<td>- Private notes</td>
<td></td>
</tr>
<tr>
<td>- Links to full-text copies</td>
<td></td>
</tr>
</tbody>
</table>

13.2. **Accented letters, non-latin letters, symbols and special characters**

To add characters such as α, á, ¼, ©, ¢, ℃, or ℗ simply copy and paste the character into the text box, or type it normally using the appropriate keyboard layout.

Be careful how you select the character in the first place. If you are using Windows, then the font *Arial Unicode MS* is probably the most appropriate to use when writing the text. You can use the ‘Character Map’ utility in Windows to select the appropriate characters. Any other method (such as the guicharmap utility in Linux) for providing literal Unicode characters can be used instead.
Fonts such as the Windows Symbol font, which makes the letter ‘a’ look like ‘α’ must be avoided, as when pasted into the text box, this will give an ‘α’. Similarly, you should use the ‘superscript 2’ character, and not format a ‘2’ character with superscript. The former will give the correct result; the latter may give a ‘2’ in some circumstances.

Older browsers such as Netscape 4 may have problems with this process. If you get unusual results when submitting the form you should upgrade to a modern browser such as Internet Explorer 7 or Firefox.

**HTML Entity references**

As an alternative to using literal Unicode characters, you can instead use the entity reference form. For example, to represent the Greek letter alpha, you could use &alpha; (named form) or &#x03B1; (hexadecimal form) or &#0945; (decimal form). You can look up characters using the code charts at [http://www.unicode.org/](http://www.unicode.org/)

### 14. Delegating editing rights

If you would like other people who are not departmental administrators to be able to update your staff profile, use the “Allow delegated editing” link in “Other options”.

**Set delegated editing rights for this profile**

People added as delegates will be able to make any changes to the profile that you are able to, including adding and removing delegates. (Your own rights to edit your profile cannot be removed, however)

Enter their @durham.ac.uk email address to add delegation rights. You can also remove delegation rights from the same page.

All delegates can make any changes to your profile that you are able to, including adding and removing delegates. (Your own rights to edit your profile cannot be removed, however)